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POUR VOTRE SECURITE Lisez ces instructions simples. Le non-respect 
de la réglementation en vigueur peut présenter un danger ou être 
sanctionné. Pour plus d'informations, reportez-vous au guide de 
l'utilisateur.

LA SECURITE SUR LA ROUTE EST UNE PRIORITE N’utilisez pas le 
communicateur alors que vous êtes au volant ; garez votre véhicule avant 
d’utiliser le téléphone.

INTERFERENCES Tous les téléphones mobiles peuvent être sujets aux 
interférences qui peuvent affecter leur performance.

ETEIGNEZ LE TÉLÉPHONE DANS LES HOPITAUX Respectez les lois ou 
les réglementations en vigueur. Éteignez le téléphone lorsque vous êtes à 
proximité d’équipements médicaux.

ETEIGNEZ LE TÉLÉPHONE EN AVION N’utilisez pas le téléphone 
lorsque vous êtes dans une station-service. Ne pas utiliser à proximité de 
carburant ou de produits chimiques.

ÉTEIGNEZ LE TÉLÉPHONE DANS UNE STATION-SERVICE N’utilisez 
pas votre téléphone dans une station-essence, ni à proximité de 
carburants ou de produits chimiques.

ÉTEINDRE A PROXIMITÉ D’EXPLOSIFS Ne pas utiliser le téléphone là où 
des explosifs sont en cours d’utilisation. Veuillez examiner attentivement 
les restrictions et suivre les règlements ou les instructions.

UTILISEZ VOTRE TÉLÉPHONE RAISONNABLEMENT N’utilisez 
l’appareil qu’en position normale (vers l’oreille). Ne touchez pas l`antenne 
si ce n`est pas nécessaire.
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UTILISEZ UN SERVICE QUALIFIÉ L’installation et la réparation des 
appareils ne doivent être effectuées que par des techniciens qualifiés.

ACCESSOIRES ET BATTERIES Utilisez uniquement des accessoires et des 
batteries agréés. Ne le connectez pas à des produits incompatibles.

EMISSION D’APPELS AVEC LE TÉLÉPHONE Refermez le couvercle et 
assurez-vous que le téléphone est bien allumé et en service. Entrez le 
numéro de téléphone, avec l’indicatif, puis appuyez sur . Pour mettre 
fin à un appel, appuyez sur . Pour répondre à un appel, appuyez sur 

.

APPELS D’URGENCE Fermez le couvercle de l’appareil. Assurez-vous que 
le téléphone est sous tension et dans une zone de service. Maintenez  
enfoncée pendant quelques secondes pour effacer l’écran. Entrez le 
numéro d’urgence, puis appuyez sur . Indiquez l’endroit où vous vous 
trouvez. Ne coupez la communication qu’après en avoir reçu 
l’autorisation.

FAITES DES COPIES DE SAUVEGARDE N’oubliez pas de réaliser des 
copies de sauvegarde de toutes vos données importantes.

CONNEXION A D’AUTRES PERIPHERIQUES Avant de connecter le 
communicateur à un autre périphérique, lisez le manuel d’utilisation 
approprié pour obtenir les instructions détaillées relatives à la sécurité. Ne 
le connectez pas à des produits incompatibles.

PRECAUTIONS CONTRE LES RAYONS INFRAROUGES Ne dirigez pas 
les rayons infrarouges vers les yeux et ne les laissez pas interférer avec 
d’autres périphériques à infrarouge.
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sur le CD-ROM
Conseil : pour plus 

d’informations sur 
l’installation des logiciels, 
reportez-vous au Guide de 
l’utilisateur.

Ce guide contient des informations sur les logiciels que vous pouvez installer à 
partir du CD-ROM fourni dans le coffret de votre produit. Ces applications se 
trouvent dans les sections « Logiciels pour Nokia 9210 Communicator » et 
« Logiciels pour PC ». Notez que certains programmes supplémentaires possèdent 
leurs propres guides de l'utilisateur. Ils figurent sur le CD-ROM en regard des 
programmes.

Pour installer des logiciels à partir du 
CD-ROM
Tous les fichiers et applications figurant sur le CD-ROM du communicateur sont 
prêts à être installés ou déplacés sur le communicateur. Procédez à l'installation 
comme suit :
1 Vérifiez que PC Suite est installé sur votre ordinateur. Vous trouverez ce 

programme sur le CD-ROM inclus dans le coffret de votre communicateur.
2 Insérez le CD-ROM dans le lecteur correspondant de votre ordinateur.
3 Première possibilité : connectez votre communicateur à votre ordinateur 

en utilisant le câble fourni dans le coffret de votre produit. 
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connexion infrarouge. Pour plus d'informations, reportez-vous au Guide de 
l'utilisateur.

4 Le CD-ROM s'ouvre automatiquement. Si tel n'est pas le cas, ouvrez l'interface 
utilisateur du CD-ROM en double-cliquant dans la structure de fichiers du 
CD-ROM sur le fichier Nokia9210.exe.

5 Dans l'interface utilisateur du CD-ROM, localisez et sélectionnez le programme 
que vous souhaitez installer, puis cliquez sur Installer.

Conseil : utilisez la carte 
mémoire du communicateur 
pour bénéficier de 
davantage d'espace pour les 
différents fichiers et 
applications du CD-ROM.

Remarque : souvenez-vous que, lorsque vous installez des applications tierces, 
la configuration de langue de celles-ci doit être identique à celle de 
votre communicateur.

Synchronisation à distance
L'application Synchronisation à distance pour Nokia 9210 Communicator vous 
permet de synchroniser votre agenda et votre annuaire via un appel de données 
GSM avec diverses applications Internet d'agenda et de carnet d'adresses ainsi 
qu'avec de nombreuses solutions internes d'entreprise telles que Lotus Notes. 
L'application de synchronisation utilise la technologie SyncML pour effectuer la 
synchronisation.

Les paramètres du serveur à distance sont appelés « modes de synchronisation ». 
Vous pouvez entrer plusieurs modes si vous avez besoin d'effectuer des 
synchronisations avec plusieurs serveurs ou applications.

Remarque : pour plus d'informations sur la compatibilité SyncML, veuillez 
contacter votre prestataire de services ou le bureau d'assistance de 
votre société.



©2001 Nokia Mobile Phones. All rights reserved.

3

Lo
gi

ci
el

s 
di

sp
on

ib
le

s 
su

r 
le

 C
D-

RO
MRemarque : ce produit inclut des logiciels développés par le corsortium 

SyncML Initiative.

Pour créer un mode de synchronisation
Lorsque vous démarrez la synchronisation à distance, le mode de synchronisation 
actuel s'affiche dans l'écran principal, sous le titre Synchronisation à distance. Si 
aucun mode n'a été créé, le texte <aucun mode défini> s’affiche. 

Pour créer un mode, procédez comme suit :

Figure 1

Conseil : lorsque vous 
ajoutez un mode à partir 
d'un autre, sélectionnez 
celui qui possède les valeurs 
les plus proches de votre 
nouveau mode.

1 Si aucun mode n'a été défini, appuyez sur Nouveau. Une boîte de dialogue 
s'ouvre. Passez à l'étape 4.

2 Si au moins un mode a déjà été défini, appuyez sur Paramètres de mode dans 
l'écran principal pour visualiser les modes disponibles. 

3 Pour créer un mode à l'aide des paramètres d'un mode existant, sélectionnez 
celui que vous souhaitez utiliser comme base et cliquez sur Nouveau. Une boîte 
de dialogue s'ouvre.

4 Définissez les éléments suivants :
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Conseil : pour faciliter 

vos créations ultérieures, 
définissez comme mode par 
défaut le mode qui est le 
plus utilisé.

Mode par défaut – Vous devez définir au moins un mode de synchronisation parmi 
ceux disponibles comme mode par défaut. Pour ce faire, sélectionnez celui 
souhaité et choisissez Oui. Le mode par défaut s'affiche dans l'écran 
principal pour que vous puissiez y accéder rapidement.

Nom du mode – Tapez un nom parlant pour le mode. Exemple : « Mon agenda de 
bureau ». Chaque mode doit avoir un nom unique.

Accès Internet/Accès Internet/Adresse de l'hôte/Port/Authentification HTTP – Pour 
connaître les valeurs appropriées, contactez votre prestataire de services 
ou votre administrateur système.

Nom d’utilisateur – Votre ID utilisateur pour le serveur de synchronisation. 
Contactez votre prestataire de services ou votre administrateur système 
pour connaître votre ID.

Mot de passe – Tapez ici votre mot de passe. Pour des raisons de sécurité, le mot de 
passe apparaît sous forme d'astérisques (*****). Contactez votre 
prestataire de services ou votre administrateur système pour connaître 
votre mot de passe.

Remarque : le bouton Paramètres n'est actif que dans le champ Authentification 
HTTP.
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Figure 2

Dans cette page, vous pouvez sélectionner les données à synchroniser avec un 
serveur. 
1 Sélectionnez l'application à l'aide des touches de direction et cliquez sur 

Modifier sélection pour choisir Oui ou Non.
2 Pour définir les paramètres de l'agenda ou de l'annuaire, appuyez sur 

Paramètres. Une boîte de dialogue s'ouvre. Définissez les éléments suivants :
Fichier agenda/Fichier d’annuaire – Appuyez sur Parcourir pour sélectionner la 
base de données appropriée parmi celles figurant sur votre communicateur.
Agenda distant/Contacts distants – Contactez votre prestataire de services ou 
votre administrateur système.
Remarque : pour pouvoir synchroniser vos données d'agenda, le fichier agenda 

doit figurer sur votre communicateur. Utilisez l'application Agenda 
pour créer un fichier agenda.
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1 Dans l'écran principal, assurez-vous d'avoir sélectionné le mode approprié. 

Appuyez sur Synchro. L'état de la synchronisation s'affiche au bas de l'écran.
2 Pour annuler la synchronisation avant qu'elle ne se termine, appuyez 

sur Annuler. 
3 Vous êtes averti lorsque la synchronisation est terminée. Appuyez sur Afficher 

journal pour ouvrir un fichier journal ou sur Fermer pour revenir à l'écran 
principal.

Pour modifier des modes de serveur existants
1 Dans l'écran principal, appuyez sur Paramètres de mode. Une liste des modes 

de serveur s’affiche.
2 À l'aide des touches de direction, sélectionnez le mode que vous souhaitez 

modifier et appuyez sur Modifier.
3 Modifiez le mode selon vos besoins. Pour connaître les valeurs appropriées, 

contactez votre prestataire de services ou votre administrateur système, ou 
reportez-vous à votre manuel. Pour plus d'informations sur les paramètres, 
reportez-vous à « Page Général » à la page 4 et à « Page Données » à la page 5.

4 Cliquez sur Fermer pour accepter les modifications et fermer la boîte de 
dialogue.

Pour supprimer des modes de serveur existants
1 Dans l'écran principal, appuyez sur Paramètres de mode. Une liste des modes 

de serveur s’affiche.
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supprimer et appuyez sur Supprimer.

Pour effectuer une synchronisation avec 
un autre serveur
1 Dans l'écran principal, appuyez sur Synchro modes. Une liste des modes de 

serveur s'affiche.
2 Sélectionnez un mode et appuyez sur Synchro.

Pour afficher les journaux de synchronisation
Vous pouvez afficher le dernier journal de synchronisation d'un mode. 
1 Dans l'écran principal, appuyez sur Synchro modes. Une liste des modes de 

serveur s'affiche.
2 Sélectionnez un mode et appuyez sur Afficher journal. Le journal vous indique 

le nombre d'éléments mis à jour, ajoutés ou supprimés.

Convertisseur d'unités
Vous pouvez utiliser le convertisseur d'unités de Nokia 9210 Communicator pour 
convertir des unités de mesure.



©2001 Nokia Mobile Phones. All rights reserved. 

8
Lo

gi
ci

el
s 

di
sp

on
ib

le
s 

su
r 

le
 C

D-
RO

M

Figure 3

Pour ouvrir l'outil de conversion, sélectionnez la catégorie de conversion dans 
l'écran principal et appuyez sur Ouvrir.

Les catégories de conversion et les unités sont les suivantes :

Catégorie de conversion Unité A Unité B

Devise USD EUR

Zone ft2 m2

Énergie kcal kJ

Longueur mi km

Masse lbs kg

Puissance hp kW

Pression Pa b

Température F C

Heure d h

Vitesse mph km/h
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L'outil de conversion pour une catégorie particulière de conversion possède deux 
cadres, reportez-vous à la figure 3.

Conseil : pour vous 
déplacer entre les cadres, 
utilisez la touche de 
tabulation.

Un seul cadre peut être actif à la fois. Les cadres ont toujours des valeurs qui se 
correspondent l'une à l'autre, donc si vous modifiez une valeur dans l'un des deux 
cadres, le deuxième cadre est automatiquement mis à jour.

Remarque : la précision de la calculatrice est limitée et des erreurs d'arrondis 
peuvent se produire.

Pour changer d'unité
Vous pouvez changer les unités utilisées dans une catégorie particulière de 
conversion. Par exemple, au lieu de convertir des dollars américains (USD) dans 
la catégorie de devise, vous pouvez effectuer la conversion à partir de francs 
français (FRF).
1 Appuyez sur Changer d'unité dans l'écran de l'outil de conversion 

correspondant à la catégorie particulière de conversion. Une boîte de dialogue 
s'ouvre.

2 Effectuez une sélection ou une recherche dans la liste en tapant une chaîne 
dans le champ de recherche.

3 Appuyez sur Sélectionner pour accepter la modification ou sur Annuler pour 
ne pas la prendre en compte.

Volume gal (US) litre
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Remarque : seules les unités de devise peuvent être modifiées, supprimées et 

ajoutées.

Conseil : pour supprimer 
une devise, sélectionnez-la 
et appuyez sur la touche 
Menu ; sélectionnez Fichier 
> Supprimer devise…. 
Appuyez sur Supprimer.

1 Sélectionnez et ouvrez la catégorie de devise.
2 Pour modifier une devise, sélectionnez-la et appuyez sur Ouvrir.

Pour ajouter une devise, appuyez sur la touche Menu et sélectionnez Fichier > 
Nouvelle devise….
Une boîte de dialogue s'ouvre.

3 Définissez les éléments suivants :
Nom – Nom de l'unité de devise.
Symbole – Abréviation de l'unité de devise.

4 Appuyez sur Calculer rapport pour définir les éléments suivants :
Rapport – Taux de conversion défini par l'unité de base.
Une boîte de dialogue s'ouvre.

5 Définissez les valeurs des unités de devise nouvelle et de base et appuyez 
sur Annuler.

6 Appuyez sur Fermer pour accepter les modifications.

Visionneuse de fichiers
La visionneuse de fichiers vous permet d'afficher de nombreux formats de fichier 
graphiques, d'éditeur de texte et autres. De plus, vous pouvez ouvrir et extraire des 
fichiers archivés.
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Figure 4

Formats supportés
Le CD-ROM contient cinq fichiers d'installation qui supportent différents types de 
formats de fichier. Vous trouverez ci-dessous la liste de fichiers d'installation ainsi 
que les formats de fichiers correspondants supportés.

Fichier d'installation Formats de fichier supportés Extensions de fichier supportées

Tous les fichiers d'installation

Texte simple TXT

Bitmap Windows BMP, RLE, ICO, CUR

Portable Network Graphics PNG

Métafichier Windows WMF, EMF

MS_Powerpoint.sis Microsoft PowerPoint 3/4/7/97/
98/2000 PPT, POT, PPS

MS_Excel.sis Microsoft Excel 2/3/4/5/7/97/
98/2000 XLS, XLC
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MS_Office.sis

Microsoft PowerPoint 3/4/7/97/
98/2000 PPT, POT, PPS

Microsoft Excel 2/3/4/5/7/97/
98/2000 XLS, XLC

Microsoft Word 1/2/4/5/6/7/97/
98/2000 DOC, WRI

Lotus_WP_AMI.sis

Lotus 1-2-3 v. 1/2/3/4/5/97/
Millenium

WQ1, WKU, WK1, WK3, WK4, 
WK5, WK6, 123

Lotus Ami Pro SAM

WordPerfect 4/5/6/7/8 WPD

WordPerfect Graphic WPG

Lotus Ami Draw SDW

Other.sis : formats d’image

Computer Graphics Metafile CGM

GIF Compuserve GIF

Paintbrush PCX, DCX

Tagged Image File Format TIF, JPG, JIF

Other.sis : Formats de texte

Langage de balisage hypertexte 
Internet HTML

Texte simple TXT

vCard VCF

Format RTF RTF
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Pour visualiser des fichiers
Remarque : les options de menu et commandes disponibles dépendent du type 

de fichier visualisé.

1 Sélectionnez Visionneuse de fichiers dans le groupe d'applications Options et 
appuyez sur Entrée.

2 La boîte de dialogue Ouvrir s'ouvre.
3 Appuyez sur Explorar pour rechercher un fichier supporté, puis sur OK pour le 

sélectionner. Le fichier s'ouvre. Selon le type de fichier, les options disponibles 
sont les suivantes :

Tous les fichiers
• Appuyez sur Zoom avant et Zoom arrière pour modifier l’affichage. 
• Appuyez sur la touche Menu et sélectionnez Affichage > Mode plein écran pour 

afficher uniquement le contenu du document ou du fichier à l'écran.
• Pour envoyer le fichier, appuyez sur Envoyer. La boîte de dialogue Envoyer 

s'ouvre. Les options sont les suivantes : Comme courrier/Par infrarouge. Appuyez 
sur Envoyer pour confirmer l'envoi.

• Pour fermer la visionneuse de fichiers, appuyez sur Fermer.

Other.sis : fichiers archivés

Winzip, PKZIP ZIP, EXE

Unix Gzip TGZ

Unix Compress TAR, TAZ

Other.sis : autres formats
Microsoft Project MPP

Visio VSD
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• Appuyez sur la touche Menu et sélectionnez Image/Document> Ajuster à la 

largeur pour agrandir le fichier de façon à ce que s'il s'ajuste à la largeur de 
l'écran.

• Sélectionnez Image/Document > Ajuster à la fenêtre pour agrandir le fichier de 
façon à ce qu'il s'ajuste à la taille de l'écran.

Documents texte et feuilles de calcul
Les menus Document ou Feuille contiennent de nombreuses options d'affichage :
• Brouillon – Pour sélectionner l'écran Brouillon, appuyez sur la touche Menu et 

sélectionnez Document > Brouillon ou Feuille > Brouillon. Dans l'écran Brouillon, 
le texte du document ou de la feuille de calcul s'affiche dans une seule police. 
Le formatage des caractères, l'alignement des paragraphes, l'espacement et les 
tabulations sont également affichés. Les objets incorporés ne s'affichent pas 
dans l'écran Brouillon. 

• Normal – Pour sélectionner l'écran Normal, appuyez sur la touche Menu et 
sélectionnez Document > Normal ou Feuille > Normal. Dans l'écran Normal 
également, toutes les polices et tous les objets incorporés s'affichent comme 
dans le document d'origine.

Conseil : lorsque vous 
affichez un document texte, 
vous pouvez sélectionner du 
texte, le copier vers le 
Presse-papiers et le coller 
dans d'autres applications.

• Page – Pour sélectionner l'écran Page, appuyez sur la touche Menu et 
sélectionnez Document > Page ou Feuille > Page. Dans l'écran Page, le texte du 
document ou de la feuille de calcul s'affiche comme dans le document d'origine 
avec également les retours à la ligne, les colonnes, les marges des pages, les en-
têtes, les pieds de page et les notes.
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• Appuyez sur la touche Menu et sélectionnez Image > Ajuster à la largeur pour 
agrandir l'image de façon à ce qu'elle s'ajuste à la largeur de l'écran.

• Sélectionnez Image > Ajuster à la fenêtre pour agrandir l'image de façon à ce 
qu'elle s'ajuste à la taille de l'écran.

• Sélectionnez Image > Pivoter pour faire pivoter l'image de 90 degrés dans le 
sens horaire.

• Sélectionnez Image > Revenir à l'image d'origine pour afficher l’image telle qu’elle 
était 
à l'ouverture.

Fichiers archivés
• Pour extraire les fichiers sélectionnés, appuyez sur Extraire. Une boîte de 

dialogue s'ouvre pour spécifier le dossier cible.
• Pour extraire tous les fichiers d'une archive, appuyez sur Tout extraire.
• Pour visualiser un fichier contenu dans une archive, appuyez sur Afficher.

Vous pouvez également trier les éléments d'une archive. 
• Sélectionnez Edition > Trier par pour définir les critères de tri. Les options 

disponibles sont les suivantes : Nom/Date/Taille.
• Sélectionnez Edition > Ordre de tri pour définir l'ordre de tri. Les options sont les 

suivantes : Croissant/Décroissant.



©2001 Nokia Mobile Phones. All rights reserved. 

16
Lo

gi
ci

el
s 

di
sp

on
ib

le
s 

su
r 

le
 C

D-
RO

M Présentations PowerPoint
Conseil : les raccourcis 

clavier pour Diapositive 
suivante / Diapositive 
précédente sont 
Maj + Ctrl + N et 
Maj + Ctrl + P.

Pour visualiser des diapositives, appuyez sur la touche Menu et sélectionnez 
Diapositive > Diapositive suivante / Diapositive précédente. Les autres commandes du 
menu Diapositive fonctionnent exactement de la même façon que dans le menu 
Image.

Pour configurer les options de la visionneuse de 
fichiers
Appuyez sur la touche Menu, puis sélectionnez Affichage > Options…. Une boîte de 
dialogue contenant deux pages s'ouvre. Définissez les éléments suivants :

Page Afficher
Police par défaut – Pour sélectionner la police par défaut, appuyez sur Changer. La 

boîte de dialogue de police s'ouvre.
Afficher fichiers inconnus – Définit de quelle façon la visionneuse gère les types de 

fichier inconnus. Les options disponibles sont les suivantes : Sous forme de 
texte/Sous forme hexadécimale/Ne pas afficher.

Afficher fichiers non supportés – Définit de quelle façon la visionneuse gère les types 
de fichier non supportés. Les options disponibles sont les suivantes : 
Demander à l'utilisateur/Ouvrir dans une application enregistrée/Comme 
inconnu.

Page Autre
Afficher quadrillage – Sélectionnez le paramètre par défaut pour le quadrillage de 

la feuille de calcul. Les options disponibles sont les suivantes : Oui/Non.
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archivés. Les options disponibles sont les suivantes : Nom/Date/Type/Taille.
Ordre de tri – Sélectionnez l'ordre de tri par défaut. Les options disponibles sont les 

suivantes : Croissant/Décroissant.
Pour fermer la boîte de dialogue, appuyez sur Fermer.

Notes

Figure 5

Notes est un éditeur de texte simple qui permet de taper des notes rapides et de 
créer des listes de notes. Vous pouvez rédiger plusieurs notes pour créer une liste 
de notes. Vous pouvez trier une liste de plusieurs façons et enregistrer une liste en 
tant que bloc-notes. L'application Notes inclut de nombreuses commandes 
standard de traitement de texte.

Notes existe uniquement en anglais.
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des blocs-notes
Pour ajouter une nouvelle note, appuyez sur New note. 

Pour supprimer une note, appuyez sur la touche Menu et sélectionnez 
File>Delete note.

Pour ajouter un nouveau bloc-notes, appuyez sur la touche Menu et sélectionnez 
File>New file. Vous pouvez disposer de blocs-notes distincts pour différents sujets.

Écrans
Conseil : l'écran Note est 

très pratique pour effectuer 
des modifications massives 
de texte. Le mode écran 
fractionné est pratique pour 
parcourir un bloc-notes.

Vous pouvez visualiser le contenu d'une note ou le contenu d'une note et d'une 
liste de notes simultanément. Pour choisir un écran, appuyez sur la touche Menu 
et sélectionnez View > Split view/Note view.

Pour vous déplacer entre les écrans en mode écran fractionné, appuyez sur 
Change Focus.

Pour afficher l'écran actuel en mode plein écran, appuyez sur Menu et 
sélectionnez View > Full screen. Pour repasser à l'écran Normal, sélectionnez à 
nouveau Full screen.

Pour formater le texte des notes
1 Sélectionnez le texte que vous souhaitez modifier.
2 Appuyez sur la touche Menu et sélectionnez les options souhaitées dans le 

menu Format :
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options pour mettre le texte en gras ou en italique, pour le souligner ou pour 
inclure des puces. 

Pour compter les mots figurant dans une note
Conseil : la 

fonctionnalité de compte de 
mots est utile lorsque vous 
souhaitez envoyer une note 
sous forme de message 
court, limité à environ 
160 caractères.

Appuyez sur la touche Menu, puis sélectionnez Tools >Word count. 

Pour vérifier l'orthographe dans une note
Si vous avez installé l'application de vérification orthographique, vous pouvez 
vérifier l'orthographe dans une note comme suit :
1 Appuyez sur la touche Menu et sélectionnez Tools > Spell check.
2 Pour plus de suggestions sur un mot inconnu, sélectionnez Suggestions, 

puis Changer.

Pour trier des notes
Vous pouvez trier des notes à l'intérieur d'un bloc-notes comme suit :
1 Appuyez sur la touche Menu, sélectionnez Tools > Sort by , puis choisissez les 

critères de tri. Les options disponibles sont les suivantes : Creation Date/
Last Modified Date/Title. 

2 Pour choisir l'ordre de tri, appuyez sur la touche Menu, sélectionnez Tools > 
Sorting Order, puis choisissez Ascending ou Descending.
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Pour afficher les préférences des notes, appuyez sur la touche Menu et 
sélectionnez Tools > Preferences. Une boîte de dialogue contenant deux pages 
s'ouvre. Définissez les éléments suivants : 

Préférences relatives à l'affichage
Show title of entries on – Choisissez d'afficher l'écran de la liste dans la partie gauche 
ou droite de l'écran fractionné.

Note width – Définissez la largeur de l'écran Note dans l'écran fractionné. Vous avez 
le choix entre 10 et 80 %.

Display – Définissez le format de date dans la barre d'état située au bas de l'écran. 
Les options disponibles sont les suivantes : Last update date/Creation date.

Préférences relatives aux notes
Always start on a new note – Vous permet de décider si l'application Notes doit 
automatiquement créer une nouvelle note pour l'utilisateur. Les options 
disponibles sont les suivantes : No/Yes.

Include in list – Vous permet de définir la quantité de texte affiché dans la liste de 
notes en mode écran fractionné. Les options disponibles sont les suivantes : 
First line/All text. L'option First line affiche uniquement la première ligne de la note. 
L'option All text affiche autant de texte que possible.

Pour imprimer des notes
Pour imprimer une note, appuyez sur la touche Menu et sélectionnez 
File > Printing > Print.... 
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MPour définir la mise en page, appuyez sur la touche Menu et sélectionnez 

File > Printing > Page setup....

Pour afficher un aperçu de la page avant de l'imprimer, appuyez sur la touche 
Menu et sélectionnez File > Printing > Print preview.... 

Pour rechercher des notes
La boîte de dialogue de recherche permet à l'utilisateur de rechercher ou de 
remplacer rapidement et facilement du texte dans le bloc-notes tout entier. 
1 Appuyez sur la touche Menu, puis sélectionnez Edit > Find.
2 Tapez le texte à rechercher. Appuyez sur Remplacer pour taper le texte de 

remplacement.
3 Appuyez sur Options pour affiner votre recherche en sélectionnant les options 

de respect de la casse, de correspondance de mot entier ou de correspondance 
partielle.

4 Appuyez sur Rechercher. L'application Notes effectue la recherche d'abord 
dans la note courante, puis dans les autres notes du bloc-notes.

5 Pour rechercher l'occurrence suivante, appuyez sur Suivant.

Multimedia Converter
Conseil : NIM désigne le 

format de fichier « Nokia 
Interleaved Multimedia ».

Multimedia Converter est une application PC. Elle vous permet de convertir les 
formats de fichiers vidéo courants en format NIM compatible avec Nokia 9210 
Communicator. Vous pouvez également convertir des formats de fichier audio 
courants au format WAV et optimiser les fichiers audio au format WAV existants 
pour les utiliser sur Nokia 9210 Communicator. Vous pouvez utiliser des fichiers 
WAV convertis en tant que sonneries, par exemple.
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Figure 6

L'utilisation du convertisseur présente des avantages majeurs :
• Lorsque vous convertissez un fichier, la taille du fichier audio ou vidéo converti 

est généralement très inférieure à la taille du fichier d'origine. Par conséquent, 
la lecture sur le communicateur ne requiert pas beaucoup de puissance de 
traitement et elle est plus fluide. En fait, de nombreux fichiers ne peuvent pas 
être lus sur le communicateur sans conversion.

• Lors de la lecture d'un fichier WAV sur votre communicateur, la qualité du son 
est meilleure.
Remarque : Multimedia Converter supporte la plupart des fichiers que vous 

pouvez lire dans Windows Media Player. Le jeu exact de fichiers 
supportés dépend de la version de Media Player installée sur votre 
système et des codecs audio et vidéo installés. Généralement, 
Multimedia Converter peut supporter la plupart des fichiers AVI, 
WAV, MPG et MP3.
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1 Dans le menu, sélectionnez Fichier > Ouvrir.... Une boîte de dialogue s'ouvre.
2 Recherchez le fichier audio que vous souhaitez convertir et cliquez sur OK. Les 

informations sur le fichier sont transférées vers les champs Original fichier situés 
dans la partie gauche de la fenêtre. Ces champs affichent le type de fichier, la 
taille du fichier et la durée de lecture.

3 Sélectionnez l'une des deux options proposées dans le champ Format audio : 
Faible compression - Pour une qualité de son supérieure
Compression normale - Pour une qualité de son inférieure mais avec une taille 
de fichier considérablement réduite

4 Cliquez sur Convertir. Les informations sur le fichier converti sont transférées 
vers les champs Converti fichier situés dans la partie droite de la fenêtre.

5 Dans le menu, sélectionnez Fichier > Enregistrer sous pour enregistrer le nouveau 
fichier.
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Conseil : la vitesse de 

cadre indique la vitesse à 
laquelle les cadres (images 
individuelles qui, dans une 
séquence, créent l'illusion 
d'un mouvement) 
s'affichent dans un film ou 
une vidéo. Cette vitesse est 
mesurée en cadres par 
seconde (fps, frames per 
second). Moins le nombre de 
cadres est élevé, plus la 
vidéo saute.

1 Dans le menu, sélectionnez Fichier > Ouvrir.... Une boîte de dialogue s'ouvre.
2 Recherchez le fichier vidéo que vous souhaitez convertir et cliquez sur OK. Les 

informations sur le fichier sont transférées vers les champs Original fichier situés 
dans la partie gauche de la fenêtre. Ces champs affichent le type de fichier, la 
taille du fichier et la durée de lecture.

3 Sélectionnez l'une des deux options proposées dans le champ Qualité vidéo :
Mouvement fluide, petites images - Pour la vitesse maximale de défilement 
des cadres. 
Mouvement normal, taille d’image normale – Pour une taille d’image normale et 
un mouvement légèrement moins fluide.

4 Si le fichier contient à la fois de la vidéo et du son, sélectionnez une des deux 
options proposées dans le champ Format audio :
Musique, compression normale – Utilisez cette option si le fichier source contient 
de la musique ou un autre type de matériel qui requiert une haute qualité 
sonore.
Voix, compression élevée – Si le fichier d’origine ne contient que du discours ou 
si la petite taille du fichier est plus importante que la qualité du son.

5 Cliquez sur Convertir. Les informations sur le fichier converti sont transférées 
vers les champs Converti fichier situés dans la partie droite de la fenêtre.
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le fichier d’origine avant la 
conversion et le fichier 
converti après la conversion. 
Utilisez les contrôles situés 
en dessous des écrans 
d'aperçu pour démarrer, 
interrompre 
momentanément ou arrêter 
la lecture.

6 Dans le menu, sélectionnez Fichier > Enregistrer sous pour enregistrer le nouveau 
fichier.
Remarque : lors de la conversion, vous ne pouvez pas démarrer la lecture de 

fichiers.

Vous pouvez utiliser PC Suite pour Nokia 9210 Communicator pour copier les 
fichiers convertis sur votre communicateur. Pour plus d'informations, reportez-
vous au guide de PC Suite qui se trouve dans le coffret de votre produit.

Jeux
Conseil : pour bénéficier 

des services de jeux Nokia, 
rejoignez le Club Nokia à 
l'adresse www.club.nokia.fr. 

Le communicateur n'est pas seulement un outil professionnel efficace, il vous 
propose également quelques distractions attrayantes pour votre temps libre. Dans 
cette section, vous trouverez des jeux épatants que vous pourrez installer sur votre 
Nokia 9210 Communicator.

Installation
Assurez-vous d'avoir connecté votre Nokia 9210 Communicator à votre PC. 
Ouvrez le CD-ROM, sélectionnez dans le dossier « Logiciels pour Nokia 9210 
Communicator/Jeux » le jeu que vous souhaitez installer, puis appuyez sur 
Installer.
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Bounce est un jeu dans lequel vous contrôlez une petite balle dans un monde 
rempli de dangers. Vous faites rebondir et rouler la balle sur chaque niveau en 
évitant les dangers et en ramassant les anneaux dont vous avez besoin pour 
déverrouiller la sortie et vous rendre au niveau suivant. Utilisez les blocs en 
caoutchouc pour rebondir plus haut ou même inverser la gravité pour récupérer les 
anneaux difficiles à atteindre. Les instructions sont disponibles à l'intérieur du jeu. 
Bounce existe uniquement en anglais.

Figure 7

Configuration requise
Bounce requiert au minimum 1,5 Mo de mémoire libre et 800 Ko d'espace disque 
disponible sur votre Nokia 9210 Communicator ou sur la carte mémoire.

Pour commencer à jouer à Bounce
1 Sélectionnez l'icône Bounce dans la liste Options à l'aide des touches de 

direction, puis appuyez sur Ouvrir.
2 Lorsque vous voyez le logo Bounce animé, appuyez sur une touche pour 

atteindre le menu principal.
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pour déplacer la surbrillance sur l'élément souhaité et appuyez sur la touche 
Entrée.

Écran principal
Le menu de l'écran principal possède cinq options : Start Game (démarrer le jeu), 
Online (connecté), Options, High Scores (meilleurs scores) et Quit (quitter). 

Pour sélectionner Quit, appuyez sur la touche de direction > et appuyez sur Entrée 
ou sur le dernier bouton de commande.

Start Game (démarrer le jeu)
Le menu Start Game possède quatre options : New Game (nouveau jeu), 
Continue (continuer), Instructions et Back (précédent). 

New Game permet de démarrer un nouveau jeu à partir du niveau 1. 

Continue vous donne accès au menu Continue (continuer).

Instructions démarre une démonstration automatique des fonctions du jeu. 

Back permet de revenir à l'écran principal.

Continue (continuer)
Le menu Continue possède quatre emplacements prévus pour les derniers jeux 
enregistrés. Chaque emplacement affiche le numéro de niveau du jeu enregistré et 
le nombre de vies restantes. La sélection d'un emplacement redémarre le jeu au 
début du niveau enregistré, avec le nombre de vies qu'il vous restait au dernier 
enregistrement. Lorsque vous chargez un jeu enregistré, votre score est de zéro ; 
par conséquent, le seule façon d'obtenir un score élevé est de jouer tous les 
niveaux du jeu en une seule partie ! Back permet de revenir à l'écran principal.
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Sélectionnez l'option Online pour vous connecter à la page d'accueil de jeux Nokia 
9210 Communicator. Notez que votre communicateur doit être configuré de façon 
à pouvoir accéder à Internet pour que cette fonction puisse être utilisée. Lorsque 
vous fermez le navigateur, vous revenez au menu principal de Bounce. Consultez 
régulièrement la page d'accueil pour obtenir des astuces, des conseils ainsi que des 
informations sur ce jeu et d'autres jeux.

Remarque : le téléphone de votre communicateur doit être allumé pour pouvoir 
utiliser cette fonction. N'allumez pas le téléphone dans des lieux où 
l'utilisation du téléphone sans fil est interdite, ou lorsqu'il peut 
causer des interférences ou créer un danger.

Options
Le menu Options possède trois options : Change Keys (redéfinir les touches), Change 
Sound (changer le son) et Back (précédent). L'option Change Keys vous permet de 
redéfinir vos touches de contrôle. L'option Change Sound vous permet de régler le 
volume des effets sonores. L'option Back vous permet de revenir à l'écran principal.

High Scores (meilleurs scores)
L'option High Scores affiche une liste de vos meilleurs scores dans Bounce. 
Sélectionnez Back (précédent) pour revenir à l'écran principal.

Contrôles
Les touches de direction < et > permettent de déplacer la balle vers la gauche et 
vers la droite. Vous pouvez faire sauter la balle à l'aide de la barre Espace. Vous 
pouvez modifier les touches de contrôle à l'aide de l'option Change Keys (redéfinir 
les touches) dans le menu Options.
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Votre balle peut changer de taille si elle touche les objets appropriés. Une grosse 
balle rebondit plus haut et se déplace plus rapidement qu'une petite balle ; elle 
peut également flotter à la surface de l'eau. La petite balle peut se faufiler au 
travers de petites ouvertures.

Démonstration
Le jeu comprend de nombreux éléments. Vous pouvez visualiser une démonstration 
des fonctions du jeu en sélectionnant Instructions dans le menu Start Game 
(démarrer le jeu). Vous pouvez quitter la démonstration à tout moment en 
appuyant sur n'importe quelle touche.

Interruption momentanée du jeu
Pour interrompre momentanément le jeu, appuyez sur la touche Échap ou sur l'un 
des boutons de commande. Une fois le jeu interrompu, vous pouvez ouvrir le menu 
Options pour redéfinir les touches et régler le volume. Vous pouvez également 
arrêter le jeu ou le reprendre.

Entre les niveaux
Avant chaque passage à un niveau supérieur, vous avez la possibilité d'enregistrer 
le jeu, de modifier les options de jeu, de quitter le jeu ou de continuer. 
L'enregistrement d'un jeu affiche une liste de quatre emplacements destinés aux 
jeux enregistrés qui contiennent les numéros de niveau des éventuels jeux 
enregistrés. La sélection de Options affiche la même liste que le menu Options dans 
l'écran principal. L'option End game (terminer le jeu) permet de quitter le jeu en 
cours et de revenir à l'écran principal. L'option Continue vous permet de passer au 
niveau supérieur.
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Le jeu prend fin lorsque vous avez terminé tous les niveaux disponibles ou perdu 
toutes vos vies. Si votre score est assez élevé à la fin d'une partie, vous avez la 
possibilité d'ajouter votre nom au tableau des meilleurs scores.

Triplepop
Triplepop est un jeu de puzzle à cadence rapide dans lequel différents ballons de 
couleur arrivent de tous les côtés de l'écran pour former un bloc au centre. En 
faisant pivoter le bloc, vous pouvez faire atterrir les ballons où vous voulez. Lorsque 
vous obtenez trois ballons de la même couleur côte à côte, ils éclatent ! Si vous 
n'êtes pas assez rapide, le bloc grossit et dépasse la limite, et vous perdez. Triplepop 
existe uniquement en anglais.

Figure 8

Configuration requise
Triplepop requiert au minimum 1,5 Mo de mémoire libre et 800 Ko d'espace disque 
disponible sur votre Nokia 9210 Communicator ou sur la carte mémoire.
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1 À l'aide des touches direction, sélectionnez l'icône Triplepop dans la liste 
Options, puis appuyez sur Ouvrir. 

2 Lorsque le logo Triplepop animé s'affiche, appuyez sur une touche pour accéder 
au menu principal.

3 Pour sélectionner des éléments dans les menus, utilisez les touches de 
direction pour déplacer la surbrillance sur l'élément souhaité et appuyez sur 
la touche Entrée.

Écran principal
Le menu de l'écran principal possède cinq options : Start Game (démarrer le jeu), 
Online (connecté), Options, High Scores (meilleurs scores) et Quit (quitter). Pour 
sélectionner Quit, appuyez sur la touche de direction > et appuyez sur Entrée ou 
sur le dernier bouton de commande.

Menu Start Game
Le menu Start Game possède quatre options : New Game (nouveau jeu), Change Skill 
(changer de niveau), Instructions et Back (précédent). L'option New Game lance un 
nouveau jeu au niveau actuellement défini. L'option Change Skill vous permet 
d'atteindre l'écran Skill Options dans lequel vous pouvez modifier le niveau et 
l'option Instructions permet d'afficher les règles du jeu. L'option Back (précédent) 
vous renvoie à l'écran principal.

Pour changer de niveau de difficulté
Le menu Skill Options affiche les trois niveaux de difficulté possibles (Easy [facile], 
Medium [moyen] et Hard [difficile]) ainsi que l'option Back pour revenir à l'écran 
principal. Le niveau sélectionné est mis en surbrillance.
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Sélectionnez l'option Online pour vous connecter à la page d'accueil de jeux Nokia 
9210 Communicator. Notez que votre communicateur doit être configuré de façon 
à pouvoir accéder à Internet pour que cette fonction puisse être utilisée. Lorsque 
vous fermez le navigateur, vous revenez au menu principal de Triplepop.

Remarque : le téléphone de votre communicateur doit être allumé pour pouvoir 
utiliser cette fonction. N'allumez pas le téléphone dans des lieux où 
l'utilisation du téléphone sans fil est interdite, ou lorsqu'il peut 
causer des interférences ou créer un danger.

Options
Le menu Options possède trois options, Change Sound (changer le son), Change Keys 
(redéfinir les touches) et Back (précédent). L'option Change Sound vous permet de 
régler le volume des effets sonores. L'option Change Keys vous permet de redéfinir 
les touches de contrôle et l'option Back vous permet de revenir à l'écran principal.

High Scores (meilleurs scores)
L'option High Scores affiche une liste de vos meilleurs scores dans Triplepop. 
Sélectionnez Back (précédent) pour revenir à l'écran principal.

Jeu
Vous avez le contrôle d'un bloc de ballons qui vient se greffer autour d'une pierre 
noire. Pendant la partie, les ballons viennent de gauche comme de droite, et se 
dirigent vers le centre où ils se collent les uns aux autres pour former un bloc.
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vous permet de modifier le point d'impact des ballons qui arrivent. Le bloc grossit 
jusqu'à ce qu'il dépasse la limite circulaire, ce qui entraîne la fin de la partie.

Les ballons existent en quatre couleurs : rouge, vert, jaune et bleu. Les chaînes de 
trois ballons (ou plus) de même couleur éclatent et disparaissent, faisant gagner 
5 points pour chaque ballon éclaté. Prenez garde aux ballons sans mouvement. 
Les chaînes de ballons sans mouvement n'éclatent pas toutes seules, mais sous 
l'influence d'une autre couleur qui se propagerait parmi elles.

Alors que la roue tourne, les ballons du bloc commencent à clignoter pour 
finalement se transformer en pierre. Ces pierres ne peuvent être détruites qu'en 
lançant des ballons à bonus spécial dessus.

Au début de la partie, vous verrez un réservoir vide de ballons à bonus. Vous 
pourrez le remplir en faisant éclater quatre ballons à la fois ou davantage. Plus la 
chaîne est grande, plus le bonus est important. Tandis que le réservoir se remplit, 
les icônes s'illuminent pour indiquer le ballon à bonus qui sera lancé lorsque vous 
appuierez sur la touche <fire> (feu). Il existe quatre types de ballon à bonus qui 
agissent différemment sur le bloc.

Les actions sont les suivantes :
• faire éclater les ballons situés autour du point d'impact dans le bloc,
• faire éclater les ballons depuis le point d'impact jusqu'à la pierre centrale,
• faire éclater un anneau de ballons autour du point d'impact dans le bloc,
• faire éclater tous les ballons dans l'anneau et au-dessus de l'anneau touché.

Si votre score est suffisamment élevé à la fin d'une partie, vous aurez la possibilité 
d'ajouter votre nom au tableau des meilleurs scores.



©2001 Nokia Mobile Phones. All rights reserved. 

34
Lo

gi
ci

el
s 

di
sp

on
ib

le
s 

su
r 

le
 C

D-
RO

M Contrôles
Les contrôles par défaut sont les suivants :
• Gauche – Touche de direction <
• Droite – Touche de direction >
• Fire (feu) – Barre Espace

Pour interrompre momentanément le jeu
Pour interrompre momentanément le jeu, appuyez sur la touche Échap ou sur 
l'un des boutons de commande. Une fois le jeu interrompu, vous pouvez ouvrir 
les options de jeu pour redéfinir les touches et régler le volume. Vous pouvez 
également arrêter le jeu ou le reprendre.

Card Deck
Le jeu de cartes Solitaire fait sans doute partie des jeux les plus familiers et 
populaires. Card Deck pour Nokia 9210 Communicator vous offre un 
divertissement intéressant et une série de jeux de cartes Solitaire.

Figure 9
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Card Deck requiert environ 1,2 Mo d'espace mémoire libre et 400 Ko d'espace 
disque disponible sur votre Nokia 9210 Communicator ou sur votre carte mémoire.

Pour démarrer Card Deck
1 À l'aide des touches direction, sélectionnez l'icône Card Deck dans le groupe 

d'applications Options, puis appuyez sur Ouvrir. 
2 Dans l'écran de démarrage de Card Deck, appuyez sur Play, puis sélectionnez un 

jeu dans la liste affichée. Pour en savoir plus sur les règles des différents jeux, 
appuyez sur Ctrl + H.

Contrôles
• Pour déplacer le curseur, utilisez les touches de direction.
• Pour passer d'un jeu de cartes à un autre, appuyez sur la touche de 

direction < ou >.
• Pour vous déplacer dans un jeu de cartes, appuyez sur la touche de direction 

Haut ou Bas.
• Pour déplacer une carte, appuyez sur la barre Espace ou sur la touche <Z>.
• Pour distribuer de nouvelles cartes, appuyez sur la touche Entrée.

Online (connecté)
Pour obtenir des conseils et astuces relatifs à ce jeu ainsi qu'aux autres jeux 
installés sur votre Nokia 9210 Communicator, visitez la page d'accueil 
correspondante à l'adresse suivante : www.nokia.com/games/92xx.
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Snake EX est une version améliorée du jeu classique Snake de Nokia pour 
Nokia 9210 Communicator.

Figure 10

Configuration requise
Snake EX requiert environ 1,2 Mo d'espace mémoire libre et 650 Ko d'espace 
disque disponible sur votre Nokia 9210 Communicator.

Pour commencer à jouer à Snake EX
1 À l'aide des touches direction, sélectionnez l'icône Snake EX dans le groupe 

d'applications Options, puis appuyez Ouvrir.
2 Dans l'écran de démarrage animé de Snake EX, appuyez sur Settings et Mode 

pour sélectionner les paramètres relatifs aux commandes, à la difficulté du jeu 
et à la fonction multijoueur. 

3 Appuyez sur Play pour démarrer un nouveau jeu.



©2001 Nokia Mobile Phones. All rights reserved.

37

Lo
gi

ci
el

s 
di

sp
on

ib
le

s 
su

r 
le

 C
D-

RO
MJeu

Déplacez le serpent vers les éléments représentant de la nourriture. L'ingestion de 
cette nourriture le fera s'allonger. Vous ne pouvez pas arrêter la progression du 
serpent ou faire reculer celui-ci. Attention à ne pas heurter les parois de l'enceinte 
ou passer sur la queue du serpent. En plus de la nourriture, des bonus peuvent 
s'afficher à l'écran. Les bonus peuvent soit faciliter le jeu, soit en augmenter 
provisoirement la difficulté. Ils s'affichent à l'écran sous forme de points 
d'interrogation. Leur effet positif ou négatif n'est pas connu tant que le serpent ne 
les a pas ingérés.

Le jeu possède deux modes. En mode Normal, vous pouvez choisir le labyrinthe 
dans lequel vous évoluez et la vitesse à laquelle le serpent se déplace. En mode 
Avancé, vous passez d'un labyrinthe à un autre lorsque vous avez atteint un 
certain score.

Vous pouvez défier vos amis à ce jeu. Vous pouvez jouer avec un seul 
communicateur, ou deux via une connexion infrarouge.

Commandes et langue
Le contrôle du serpent s'effectue de trois façons :
• Directe – à l'aide des touches de direction.
• Relative – à l'aide des touches de direction < et >. Le serpent se déplace dans 

le sens horaire ou anti-horaire.
• En diagonale – à l'aide des flèches Diagonales. La flèche supérieure gauche 

permet de déplacer le serpent vers le haut ou vers la gauche tandis que la flèche 
inférieure droite permet de déplacer le serpent vers le bas ou vers la droite, par 
exemple.
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M Le serpent a une langue. Vous pouvez l'utiliser pour attraper la nourriture à 
distance. Utilisez la barre Espace pour commander la langue.

Niveaux de difficulté
Le jeu comporte cinq niveaux de difficulté. Au premier niveau, le serpent se déplace 
lentement et est facile à contrôler. Aux niveaux supérieurs, le serpent se déplace 
plus rapidement, mais l'ingestion de nourriture rapporte davantage de points.

Labyrinthes
En mode Normal, vous avez la possibilité de définir au début du jeu le labyrinthe 
dans lequel vous souhaitez que le serpent évolue. Chaque labyrinthe a sa 
configuration de bonus et d'éléments de nourriture. Le mode Avancé débute au 
premier labyrinthe et évolue vers un labyrinthe plus complexe après l'obtention 
d'un certain score.

Bonus
Le jeu comporte sept bonus différents. Ils peuvent soit faciliter le jeu, soit en 
augmenter provisoirement la difficulté. Vous ne pouvez pas en connaître les effets 
par avance.
• Profusion de nourriture : de la nourriture supplémentaire s'affiche à l'écran.
• Caractère invincible : le serpent peut traverser les murs et passer sur sa queue 

sans mourir.
• Réducteur : réduit la taille du serpent. L'effet est permanent.
• Ralentisseur : réduit la vitesse de déplacement du serpent.
• Fonctions inversées : inverse vos commandes de jeu.
• Langue : double la longueur de la langue.
• Turbo : augmente la vitesse de déplacement du serpent.
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MAutres

Polices
Des polices supplémentaires permettant d'augmenter le nombre de styles de 
caractère sont disponibles pour votre communicateur dans le sous-dossier Others.

Correcteur orthographique
Si vous installez l'application Spell checker sur votre Nokia 9210 Communicator, 
vous pourrez ensuite vérifier l'orthographe des mots et du texte que vous aurez 
tapés dans les applications, telles que Word, où Vérification orthographique… figure 
parmi les options de menu. Pour plus d'informations sur la vérification 
orthographique, reportez-vous à « Pour effectuer une vérification 
orthographique » à la page 36 du guide de l'utilisateur.

Remarque : vous ne pouvez vérifier l'orthographe que dans le cas de mots et de 
textes anglais.
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